
Design Guide: TIDA-010086
数字控制成本优化型 10A 电池化成与测试参考设计

说明

本参考设计为多通道电池化成与测试应用提供了一种具
有成本效益的设计。该设计采用 C2000™ 实时微控制

器 (MCU)，搭载 16 通道同步采样精密 ADC，并可扩

展来支持 8 通道电芯测试。该设计采用 HRPWM 模块

实现精确占空比控制，从而达到精密数模转换器的性

能，同时节省超过 30% 的物料成本。该 MCU 集成了 

2p2z 控制，可实现恒流 (CC) 和恒压 (CV) 控制运行。

多通道 ADC 通过软件优化了电流与电压环路的灵活

性。该设计持通过单一方式实现多级电流与电压输出。

资源
TIDA-010086 设计文件夹

TMS320F28P65 产品文件夹

ADS9324、INA630 产品文件夹

UCC27284、REF50E 产品文件夹

请咨询我司 TI E2E™ 支持专家

特性

• 高达 10A 的双向电流控制，精度小于 ±0.02%
• 支持 ±5V 真双极性输入且可直接连接到电池电芯的 

16 通道 SAR ADC
• 充电和放电时均支持恒压模式，调节误差

< ±1mV
• 软件频率响应分析器 (SFRA) 可实现简单的闭环瞬

态响应调优

应用

• 电池测试
• 可编程直流电源
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1 系统说明

1.1 锂离子电芯化成设备

电池测试仪设备包括各种用于测试单个电芯、电池模块和高压电池包的设备。需要执行各种测试来验证锂离子或
其他类型电池电芯的性能、容量和安全性。电池化成是电芯制造中的关键步骤之一。这个过程需要对单个电芯进
行精密的充电和放电，以形成固体电解质界面 (SEI) 层。电芯分级和电气测试可评估每个电芯的容量和内部电阻。

这些测试需要准确的电流和电压充放电曲线和实时数据记录，以获取详细的性能数据。

典型的测试设备需要精密双向电源和数据采集系统，以实现对电池电芯的高精度电流和电压充电或放电，精度通

常优于满量程的 ±0.05%。随着电池容量的提升以及集成化多功能测试系统的普及，多通道电源得以实现更大数量

的电池电芯测试通道。

可采用两种方法管理充放电周期并提供精密测试条件。表 1-1 所示为这两种方法之间的差异：

表 1-1. 模拟和数字控制

方面 模拟控制 数字控制

控制逻辑 使用模拟元件的基于硬件的反馈环路 在 DSP 上运行的基于软件的算法

灵活性 配置固定；变更需修改硬件
可通过软件灵活配置；易于实现负载补偿并支持多种测

试配置文件

复杂性 基本功能设计更简单，但高级功能的实现更加复杂 软件开发更复杂，但硬件结构更简洁，易于扩展

响应时间 得益于模拟反馈，具有快速、连续的响应 快速响应需要具有微秒级延迟、ADC 及 MCU 速度

精密 高精度且对元件容差和漂移敏感
在具备适当 ADC 分辨率和校准能力时可实现高精度；
抗漂移能力更强

数据记录 有限；需要额外的电路进行数据采集
内置通过 MCU 记录数据的功能，支持详细分析和可追

溯性

成本 简单系统成本较低；复杂的高精度设计成本较高 对于可扩展的多功能系统更具成本效益

TIDA-010086 参考设计采用数字控制方案，基于 TMS320F28P650DK MCU 与 16 通道集成 PGA、SAR ADC，
构建多通道同步降压转换器，实现高精度、快速响应与高信号链密度设计。

1.2 主要系统规格

表 1-2. 主要系统规格

参数 规格

低压端口 – 电池端口 50mV 至 5V

高压端口 – 总线电压 12V 至 15V

开关频率 250kHz

每通道最大双向直流电流 10A

电流控制精度 ±0.02% FSR

电压控制精度 ±0.02% FSR

电流瞬变时间 < 100μs

功率级和运行模式 同步降压转换器，CCM 模式
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2 系统概览

2.1 方框图

图 2-1 显示了参考设计的方框图。TMS320F28P650DK MCU 为同步降压功率级生成高分辨率 PWM，并执行电流

和电压控制功能。INA630 电流检测放大器检测电池电流，ADC 终端直接连接到电池以进行电压检测。电流和电

压信号由外部 ADS9324 ADC 转换为数字数据。C2000™ 片上窗口比较器实现过流保护。
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图 2-1. TIDA-010086 系统方框图
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2.2 系统设计原理

2.2.1 反馈控制器

图 2-2 显示了电流和电压控制环路的软件实现。电压环路与电流级联，以便在充电和放电模式下实现恒流和恒

压。当电池电压远离恒压设置 (VSET) 时，电压环路饱和至恒流设置 (ISET)。当电池电压接近 VSET 时，电压环

路闭合，并且 ISET 减少以确保电池电压不超过 VSET 限值。该控制器可在充电和放电模式下工作。在充电模式

下，VSET 限制最大电池电压，从而停止充电。在放电模式下，VSET 限制旨在停止放电的最小电池电压。
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图 2-2. CCCV 反馈控制器

2.2.2 直流/直流转换器启动

双向功率级用于对电池进行充电和放电。在正常启动条件下，降压转换器输出从 0V 增加到目标电压。如果在降压

转换器从 0V 斜升时连接电池负载，这会导致很大的电流过冲。可以通过两种方法来避免问题。第一种方法是在输

出继电器断开的情况下启动降压转换器，并在降压转换器接近电池电压时将继电器设置到闭合位置，如图 2-3 所
示。第二种方法是在 DCM 模式下启动降压转换器，其中低侧开关在充电期间断开，或高侧开关在放电期间断开，
如图 2-4 所示。从非同步模式切换到同步模式需要一个计时器。
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图 2-3. 同步启动
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图 2-4. 非同步启动

2.2.3 高分辨率 PWM 生成

高分辨率 PWM 可实现高精度反馈控制。该高分辨率计数器提供了 150ps 的时间阶跃功能。对于 250kHz 的开关

频率和 200MHz EPWMCLK，这种方法可提供大约 14.7 位的分辨率。表 2-1 显示不同开关频率下的 PWM 分辨

率。

表 2-1. PWM 和 HRPWM 的 C2000™ MCU 分辨率

PWM
频率

常规分辨率 (PWM) 高分辨率 PWM
100MHz EPWMCLK

(kHz) 位 % 位 %
20 12.3 0.02 18.1 0

50 11 0.05 16.8 0.001

100 10 0.1 15.8 0.002

150 9.5 0.15 15.2 0.003

200 9 0.2 14.8 0.004

250 8.6 0.25 14.4 0.005

2.2.4 输出电感器和电容器选型

输出电容器的值和电容器的 ESR 决定了输出电压纹波和负载瞬态性能。该电容器旨在实现出色的输出电压纹波和

负载瞬态性能。

方程式 1 计算降压电流的占空比。

D = VOUT maxVIN min × Efficiency = 6 V12 V × 90% = 55 . 5% (1)

电感器纹波电流通常定义在输出电流的 0.2 至 0.3 倍之间。由于控制环路需要快速响应，可以按较小的值来选择

电感器。因此选择 0.2 作为纹波电流系数。在计算一些裕度时使用了 12A 的满量程，因此电感器纹波电流估计为

2.4A。

当 Toff 达到方程式 2 中所示的最大值时，降压转换器中连续导通模式 (CCM) 的最坏情况就会发生。

∆ IL = VOUT max × 1 − DfS × L (2)
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求解该公式，电感值需要高于 4.45μH。电感器的电感值越小，具有的饱和电流越大。该设计选择了 4.7μH 电感

器。方程式 3 计算实际电感器电流。

∆ IL = 6 V × 1 − 0.555250 kHz × 4 . 7 μH ≅ 2 . 27 A (3)

方程式 4 计算在不考虑 ESR 的情况下的输出电容。

Cout = ΔIL8 × fsw × ∆VOut_Ripple (4)

输出电压纹波目标为最大输出电压的 0.1%，即 6mV。插入方程式 4，然后计算得出输出电容为 192μF。在该设

计中，并联放置了四个 47μF 和两个 1μF 陶瓷电容器以匹配该电容。

输出电容器的 ESR 要求对于确定总输出电压纹波也至关重要。ESR 越高，会导致整体输出电压纹波越高。要计

算 ESR 要求，请使用以下公式计算仅由电容器和仅由 ESR 引起的电压纹波：

Vo_pp = ΔIL8 × Cout × fsw 2 + ΔIL × RESR 2 (5)

6 mV = 2.4 A8 × 190 μF × 250 kHz 2 + 2.4 A × Resr 2 (6)

求解得出 Resr ≅ 0.5mΩ。该值可通过并联陶瓷电容器实现；每个电容器在 250kHz 开关频率下具有约 1.5mΩ 的 

ESR。并联电容器可以将总 ESR 降低到 1mΩ 以下。

2.2.5 电流和电压反馈

该设计的目标是在 ±5°C 温度变化范围内实现 ±0.02% 的 FS 电流和电压控制以及测量精度。电流检测通过仪表放

大器实现，测量分流器两端的电压并调节至 ADC 输入电压。

偏移电压和增益误差不是大问题，因为它们可以在设备中进行校准。但是，增益和温漂是实现精度 ±0.02% 或 

±200ppm 的关键参数。当大电流通过输出级时，较小的分流电阻器有助于降低热耗散和总温漂。参考设计在 10A 
满量程电流范围内采用 2mΩ、25ppm/°C 分流器。使用 INA630 执行电流检测，该仪表放大器的间接电流反馈 

(ICFB) 拓扑使其成为一种具有成本效益的检测方法，因为它不需要对内部精密修整电阻器进行激光修整，并通过

分立式外部电阻器设置增益。

INA630 具有 0.5μV/°C 的输入温漂和 3ppm/°C 的典型增益漂移，对于 2mΩ 感应电阻器和 10A 满量程电流额定

值，信号链漂移为 25.18ppm/℃。由于增益取决于外部电阻分压器的匹配情况，因此更好的温度系数也可以降低

增益漂移。为了获得最佳性能，使用匹配电阻器对可以将增益漂移误差降到最低。

总 ADC 漂移源于电压基准，以 REF50E 为例，其温漂为 2.5ppm/°C。电流路径的总未调整误差为 ±5 ℃ × 252 × 2 . 5 2  ppm/ ℃ = ± 126 . 5ppm 这符合设计要求。

电压检测路径在温度变化下具有更优的误差裕量。ADS9324 具有 1MΩ 输入阻抗，可通过集成式可编程增益放大

器支持 ±5V 的输入范围。对于正负模拟输入，它可以直接连接到 5V 电池，因此无需外部差分放大器并降低了 

BOM 成本。它还具有最小 100dB 的 CMRR，可以支持高精度电压检测。对于 5V 电芯中摆幅为 ±1V 的情况，
CMRR 导致的误差为 ±5μV 或满量程电压范围的 ±10ppm。温漂为 0.5ppm/℃，因此总误差可以更轻松地降到 

50ppm 裕度以下。
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2.3 重点产品

2.3.1 TMS320F28P650DK

TMS320F28P650DK C2000 器件用于控制同步降压功率级。该器件具有 36 个 HRPWM 通道，足以控制 18 个降

压转换器。有关更多信息，请参阅 TMS320F28P65x 实时微控制器数据表。

2.3.2 ADS9324

ADS9324 是一款 16 通道、同步采样、16 位同步采样 (SAR) 模数转换器 (ADC)。该器件支持每通道高达 

750ksps 的最大采样率，并具有 15kHz 和 30kHz 的集成 LPF 以降低噪声。真正的双极性输入范围可以接受 ±5V 
和 ±6.25V 作为 ADC 满量程，因此该器件可以省去精密电压检测放大器。当连接到电池电芯时，ADS9324 足以

实现 ±0.01% 的精度和 1.5kHz 环路带宽。有关更多信息，请参阅 ADS9324。

2.3.3 INA630

INA630 是一个精密、成本优化型间接电流反馈仪表放大器，在增益为 100 时具有低输入偏移电压 (0.7μV/C) 和
典型增益漂移 (2.5ppm/C)，这可在 ±5°C 温度变化范围内实现 ±0.02% 的电流控制精度。另请参阅 INA630 精
密、126dB CMRR、间接电流反馈仪表放大器数据表。

2.3.4 UCC27284

UCC27284 是一款功能强大的 N 沟道 MOSFET 驱动器，最大开关节点 (HS) 额定电压为 100V。借助此器件，可

在基于半桥或同步降压配置的拓扑中控制两个 N 沟道 MOSFET。该器件具有 3A 拉电流和灌电流能力，典型传播

延迟为 16ns，可更大限度地降低死区时间要求并进一步提高效率

2.3.5 REF50E

REF50xxE 是一款噪声低、漂移低、精度电压基准极高的产品系列。它采用专有的设计技术实现了出色的温漂 

(2.5ppm/°C) 和高精度 (0.025%)。再结合非常低的闪烁噪声 (0.5μVPP/V)，使 REF50xxE 系列非常适合用于高精

度数据采集系统。
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3 硬件、软件、测试要求和测试结果

3.1 硬件要求

图 3-1 展示了 TIDA-010086 硬件的各个部分。该电路板需要 F28P65 控制卡评估模块来测试硬件和软件性能。

HV Input 12-15V

GND

TMS320F28P6

5 Control Card

ADS9324

Ch4Ch3Ch2Ch1

Ext ADC 

data read 

ISR3

ADC DRDY 

& Run 

Control Loop

 ISR2

INT ADC Clock 

& CONVST 

ISR1

图 3-1. TIDA-010086 硬件

使用了以下设备来评估参考设计：

• 直流输入电源：HP 6675A
• 实验电源：Agilent E3634A
• 直流负载：Chroma 63102A
• 6.5 位分辨率万用表：Agilent 34401A
• 示波器：Tektronix MDO34

硬件、软件、测试要求和测试结果 www.ti.com.cn

8 数字控制成本优化型 10A 电池化成与测试参考设计 ZHCU750A – NOVEMBER 2020 – REVISED DECEMBER 2025
提交文档反馈

English Document: TIDUEY0
Copyright © 2026 Texas Instruments Incorporated

https://www.ti.com/tool/TMDSCNCD28P65X
https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCU750
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCU750A&partnum=TIDA-010086
https://www.ti.com/lit/pdf/TIDUEY0


3.2 软件

该软件使用 Code Composer Studio (CCS) 集成开发环境 (IDE)，可在 C2000WARE-DIGITALPOWER-SDK 库中

找到。

3.2.1 在 Code Composer Studio™ 中打开工程

使用以下步骤在 Code Composer Studio (CCS) 中启动工程：

1. 从 Code Composer Studio (CCS) 集成开发环境 (IDE) 工具文件夹安装 Code Composer Studio。建议使用版

本 12.4 或更高版本。

2. 通过以下两种方式之一安装 C2000WARE-DIGITALPOWER-SDK：
a. 转至 CCS 并点击 View → Resource Explorer。在 TI Resource Explorer 下，转至 C2000WARE-

DIGITAL-POWER-SDK，然后点击安装按钮。

b. 通过 C2000Ware Digital Power SDK 工具文件夹

3. 安装完成后，关闭 CCS，然后打开一个新的工作区。CCS 自动检测 powerSUITE。有时必须重新启动 CCS 
才能使更改生效。

备注
默认情况下，powerSUITE 随 SDK 一起安装。

现在，可以使用以下方法之一导入固件工程：

• 使用 Resource Explorer
1. 在 Resource Explorer 中的 C2000WARE-DIGITAL-POWER-SDK 下，点击 powerSUITE → Solution 

Adapter Tool。
2. 从直流/直流部分下提供的设计列表中选择 TIDA-010086。
3. 将显示开发套件页面。用于运行工程的图标显示在顶部栏中。点击 Run Project。
4. 此操作将工程导入到工作区环境中，并显示具有与图 3-2 类似的 GUI 的配置页面。

5. 如果不显示该 GUI 页面，请参阅 C2000WAREDIGITAL-POWER-SDK 资源浏览器中 powerSUITE 下的

“常见问题解答”部分。

• 直接从 solution 文件夹导入：
1. 用户还可以执行以下操作来直接导入工程：进入 CCS 内，点击 Project → Import CCS Projects，并导航

到位于 /solutions/tida_010086/f28p65x/ccs 中的 solution 文件夹。

2. 出现两个工程规范：一个工程规范带有 powerSUITE，另一个工程规范不带 powerSUITE。点击任一规范

都会创建该工程的一个自包含文件夹，其中包含所有依赖项。

3. 以下所有步骤介绍了如何修改 settings.h 和 user_settings.h 文件中的相关 #defines，本设计指南进行了相

关说明。
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图 3-2. 该设计的 powerSUITE GUI 页面
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3.2.2 工程结构

图 3-3 显示了项目的总体结构。导入工程后，CCS 内将显示 Project Explorer，如图 3-4 所示。

备注
图 3-4 展示了 F28p65x 的工程；不过，如果从页面中选择不同的器件，则结构是类似的。

图 3-3. 工程结构概览

含有核心算法代码的特定于解决方案并且独立于器件的文件位于 .c/h 中。

特定于电路板和特定于器件的文件位于 _hal.c/h 中。该文件包含用于运行解决方案的特定于器件的驱动程序。如

果用户想要使用不同的调制方案或不同的器件，除了更改工程中的器件支持文件，用户只需要对这些文件进行更

改。

-main.c 文件包含工程的主要框架。该文件包含对电路板和解决方案文件的调用（有助于构建系统框架）以及中断

服务例程 (ISR) 和慢速后台任务。

对于该设计，解决方案为 bt4ch。

可通过点击 Project Explorer 下列出的 main.syscfg 文件来打开 powerSUITE 页面。该页面生成 _settings.h 文
件。该文件是由 powerSUITE 页面生成的用于工程编译的唯一 C 语言文件。用户不得手动修改该文件，因为每次

保存工程时，powerSUITE 都会覆盖更改。_settings.h 文件包含工作模式选择功能以及电流和电压控制环路补偿

设置。 _user_settings.h 包含在 _settings.h 中，可用于保留 powerSUITE 工具无法配置的任何设置，例如 

ADC 映射、GPIO 等的 #defines。

_cal.h 文件包含用于电流和电压测量的增益和偏移值。

_.ccxml 设置用于参考设计的调试器。在该设计中，连接了 XDS110 USB 调试探针，目标器件为 

TMS320F28P65DK9。

Kit.json 和 solution.js 文件由 powerSUITE 在内部使用，不允许用户进行修改。对这些文件进行的任何更改都会

导致工程无法正常运行。
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解决方案名称也用作解决方案中使用的所有变量和定义的模块名称。因此，所有变量和函数调用都以 BT4CH 作
为前缀（例如，BT4CH_userParam_chX）。这种命名规则让用户能够组合不同的解决方案，同时避免命名冲

突。

Device Support 

Library and Libraries 

Used For the Solution  

Setup Different 

Channel with 

JavaScript

Project 

Name

Solution Specific

Files for Power 

Stage and ADC 

setup

Target Configuration for 

Debugger Connection

图 3-4. BT4PH 工程的 Project Explorer 视图

bt4ch 工程由三个 ISR（ISR1、ISR2 和 ISR3）组成。

• ISR1 用于检测降压转换器的输入电源电压和输出电容器电压。ISR1 在 ADCC 转换完成时触发，并以与外部 

ADC CONVST 相同的频率运行。ADCC 检测转换器的输入电压和输出电压，输出用于实现 DC/DC 转换器的

软启动。
• ISR2 由 ADS9324 的 BUSY 信号触发。外部 ADC 编程为 400kSPS 采样率 (CONVST)，过采样率 (OSR) 设

置为 8，这会将 ISR 频率设置为 50kHz。
• ISR3 由 SPI 接收 FIFO 中断来触发。ISR 用于从 FIFO 寄存器中读取外部 ADC 数据以及运行控制环路功能。

图 3-6 显示了当全部四个通道都开启时 ISR1、ISR2 和 ISR3 所用的时间。三个 ISR 所用的总时间小于 6μs，这

小于 50kSPS 控制环路采样率下 CPU 使用率的 30%。图 3-5 和图 3-7 显示了只有一个通道开启而其他所有通道

关闭时的 ISR 时间。
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图 3-5. 一个通道的 ISR 执行时间

图 3-6. 四个通道的 ISR 执行时间

图 3-7. 所有通道都关闭时的 ISR 执行时间

3.2.3 软件流程图

图 3-8 展示了软件流程图。
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bt4ch_hal.c/h, ads93xxV_hal.c/h, ads93xxV.c/h, and bt4ch_gan_cal.h files are necessary to run the bt4ch_main.c and bt4ch.h/c

main()

//Psuedo code

//Setup device, init interrupt, cputimer

//Setup analogpinmux

// Setup internal ADC

//Setup clock for external ADC

//Setup HRPWM for the power stage

//Enable phase shift

//Configure comparators for overcurrent protection

//Setup SFRA

//Setup SPI for external ADC

//Configure external ADC

//Initial variables used in the program

//Enable interrupts

//Configure output relay

bt4ch_main.c

Background Loop

A1-> BT4CH_updateEnable(..),BT4CH_updateReference()

A2-> BT4CH_SFRA_GUI_RUN_COMMS

A3->BT4CH_updateHrpwmMepScaleFactor();

B1->BT4CH_monitorIoutVout();

B2->BT4CH_SFRA_RUN_BACKGROUND();

B3-> BT4CH_HAL_enableRelay

C1-> BT4CH_HAL_toggleRunLed

ISR1

Restore Context Return

BT4CH_HAL_storedata_VSENSE()

ISR2

Restore Context Return

BT4CH_HAL_ExtAdcSendTxFrame();

ISR3

Restore Context Return

BT4CH_HAL_ExtAdcRead();

BT4CH_runPwmISR();

bt4ch.h

Definition of all global variables for the

solution module

BT4CH_initUserVariables();

…

BT4CH_setControlCoeffcients();

…

BT4CH_setupSfraGui();

…

BT4CH_updateEnable();

BT4CH_updateEnable();

BT4CH_updateReference();

Declaration of all global variables for the

solution module

BT4CH_dcmStartup();

BT4CH_controlCC();

BT4CH_controlCV();

BT4CH_storedataExtAdc();

BT4CH_updateHrpwmMepScaleFactor();

bt4ch.c

Return

BT4CH_storedataExtAdc();

…

BT4CH_controlCC();

….

BT4CH_controlCV();

…

BT4CH_runPwmIsr()

图 3-8. 软件流程图
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3.3 测试设置

3.3.1 用于测试双向功率流的硬件设置

图 3-9 展示了双向电源的测试设置。输入直流电源的工作电压为 12V 至 15V，作为输入总线电压。当输入电源无

法支持双向电流时，电子负载 (e-load) 可提供放电模式。在电池侧，系统连接到实验室电源和电子负载，以模拟

电池电芯的充电或放电。

TIDA-010086

DC Source

12V – 15V

E-Load

CC mode

DC Source

0-5V

E-Load

CC Mode

12-V Bus Battery Port

图 3-9. 用于测试双向功率流的硬件设置

3.3.2 用于对电流和电压环路进行调优的硬件设置

控制环路仅在单通道运行期间需要调优。工程师使用此方法来调优电流和电压环路。电池负载表现为小阻抗电
缆，范围为几毫欧至数百毫欧。在没有外部仪表的情况下，与实际电池电芯相比，阻抗匹配电缆提供了一种调优

控制环路的简单方法。

TIDA-010086
DC Source

Output Shorted condition 

with cable resistance close 

to an actual battery 

resistance

Tune Channel by Channel

图 3-10. 用于对电流和电压环路进行调优的硬件设置

3.3.3 用于电流和电压校准的硬件设置

为了校准电流和电压，使用 6.5 位万用表测量输出终端电压和分流器两端的压降。电流校准使用电子负载恒流模

式或短路条件。电压校准使用开路条件。
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TIDA-BOARD

DC Source

12 V to 15 V

E-load

CC Mode

12-V Bus Battery Port

6 ½ Digit DMM

Current Measurement

6 ½ Digit DMM

Voltage Measurement

图 3-11. 用于电流和电压校准的硬件设置

3.3.4 实验变量定义

BT4CH_userParam_ch1,2,3,4 变量用于在不同的实验中控制功率级。有关参数定义，请参阅表 3-1。

表 3-1. BT4CH_userParam_chX 定义

BT4CH_userParam_chX 数据类型 注释

Iref_A float 设置充电和放电模式的电流 [0，10]

VrefCharge_V float 设置充电模式下的电压 [0，5]

VrefDischarge_V float 设置放电模式下的电压 [0，5]

Dir_bool unsigned int
对于充电模式，将此参数设置为 1

对于放电模式，将此参数设置为 0

Relay_ON unsigned int
将此参数设置为 1 可启用继电器

将此参数设置为 0 以禁用继电器

En_bool unsigned int
将此参数设置为 1 以启用该通道

将此参数设置为 0 以禁用该通道

remote_sense unsigned int
将此参数设置为 1 可使用遥感进行闭环控制

将此参数设置为 0 可使用本地检测进行闭环控制

DutyRef_pu float 开环模式的基准占空比。范围 = 0 至 1.0

IbatCal_pu float 在校准模式下使用此参数设置输出电流。范围 = 0 至 1.0

VbatCal_pu float 在校准模式下使用此参数设置输出电压。范围 = 0 至 1.0

IoutGain_pu float 该变量存储电流增益校准数据

IoutOffset_pu float 该变量存储电池电流偏移校准数据

IoutGain_A float 该变量存储电池电流增益校准数据

IoutOffset_A float 该变量存储电池电流偏移校准数据

VoutGain_pu float 该变量存储电池降压转换器输出电压增益校准数据

VoutOffset_pu float 该变量存储降压转换器输出电压偏移校准数据

VoutGain_V float 该变量存储降压转换器输出电压偏移校准数据

VoutOffset_V float 该变量存储降压转换器输出电压偏移校准数据

VbatGain_pu float 该变量存储电池电压校准数据

VbatOffset_pu float 该变量存储电池电压偏移校准数据

VbatGain_V float 该变量存储电池电压增益校准数据

VbatOffset_V float 该变量存储电池电压偏移校准数据
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3.3.5 测试程序

3.3.5.1 实验 1.开环电流控制 - 单相

3.3.5.1.1 设置实验 1 的软件选项

1. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 2，否则跳至步骤 3。
2. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 1: Open Loop CC Single Channel
• 选择四个通道中的任一个
• 启用 SFRA
• 保存该页面

3. 当使用非 powerSUITE 版本的工程时，直接在

solution_settings.h 文件中修改上述设置。

#define LAB_NUMBER (1)
#define CHANNEL_NUMBER (1)
#define SFRA_ENABLED (true)

图 3-12. 实验 1 的构建选项

3.3.5.1.2 生成和加载工程以及设置调试环境

使用以下步骤来构建和加载工程并设置调试环境。

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 这将成功生成工程。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在监视/表达式窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制

台的右上角，点击 Open，然后浏览到位于工程文件夹内的 setupdebugenv_chX.js 脚本文件。这将在观察

窗口中填入调试系统所需的合适变量。

7. 点击监视窗口中的 Continuous Refresh 按钮 ，以启用控制器中值的持续更新。
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3.3.5.1.3 运行代码

使用以下步骤运行实验 1 的代码：

1. 使用节 3.3.2 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT4H_InputVoltageSense_V 是否处于 12V 至 15V 范围内。

4. 如果频率为 50kHz，则使用示波器检查外部 ADC 的 DRDY 信号。图 3-13 显示了 MCU 运行时 ADS9324 
DRDY 和 CONVST 信号。

5. 从 Expression Window 中设置以下参数：
• BT4CH_userParam_chX->dutyRef_pu = 0.02
• 设置 BT4CH_userParam_chX->en_bool = 1
• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器

• 有关 Expression Window 设置，请参阅图 3-14
6. BT4CH_measure_V_I_chX 变量显示 DC/DC 转换器的输出电流和电压。调整 BT4CH_userParam_chX-

>DutyRef_pu 以确保电流大概为 4.5A。
7. 图 3-15 显示了用于提取开环电流控制的受控体模型的 SFRA 设置。点击 SysConfig 页面中的 Run SFRA 图

标。此时将弹出 SFRA GUI。
8. 在 SFRA GUI 上选择器件对应的选项；例如，对于 F28P65x，请选择 Floating Point。点击 Setup 

Connection 按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击 

OK 按钮。返回到 SFRA GUI，然后点击 Connect 按钮。

9. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 启动 SFRA 扫描。完整的 SFRA 扫描需要几分钟

才能完成。完成之后，即显示包含测量值的图形，如图 3-16 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

11. 完成实验后，在 Expression Window 中设置以下参数以停止代码：
• BT4CH_userParam_chX->dutyRef_pu = 0
• 设置 BT4CH_userParam_chX->en_bool = 0
• 将 BT4CH_userParam_chX->Relay_ON 设置为 0 以禁用输出继电器

• 终止程序

图 3-13. ADS9324 CONVST 和 DRDY 信号
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图 3-14. 实验 1 表达式窗口，开环
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GND
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SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCIout

图 3-15. 用于开环电流控制的 SFRA 设置
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图 3-16. 电流控制开环频率响应

3.3.5.2 实验 2.闭环电流控制单通道

3.3.5.2.1 设置实验 2 的软件选项

1. 要运行该实验，请确保按前面部分（即节 3.3.2）所述设置硬件。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 2: Closed Loop CC Single Channel
• 选择通道
• 启用 SFRA

• 通过点击 Run Compensation Design 按钮打开补偿设计器 。

• 然后，补偿设计器启动并提示用户选择有效的 SFRA 数据文件。将实验 1 中运行的 SFRA 数据导入补偿设

计器来设计双极点、双零点补偿器。在此迭代设计过程中保持更大的裕度，以确保环路闭合时，系统是稳

定的。
4. 该设计使用 2p2z 控制模式，该模式也可以建模为带 OTA 的 II 型补偿器。为了调优控制环路，该设计采用了

以下步骤：
• 首先，选择所需的交叉频率 ƒc 和相位裕度 p0。记下交叉频率响应分析器中的开环受控体增益 Gƒc 和受控体

相位 p1。

• 相位提升作为实现 p0 的补偿量，所需的交叉频率 ƒc 可以通过方程式 7 计算。

• 要计算补偿极点频率 ƒp，可使用方程式 8。
• 当相位在极点和零点之间的几何平均值处达到峰值时，使用方程式 9 计算零点 ƒz 的补偿。

• 对于带 OTA 的 II 型补偿器，交叉频率的传递函数可以表示为无法自动生成链接文本。

• 应用方程式 8 和 ƒz 中的极点和零点，可以根据方程式 11 计算 Kdc。
• 第二个零点位置可以放置在远高于第一个零点的位置。
• 通过将方程式 8、ƒz 和 Kdc 的极点和零点应用到补偿设计器中，可以在 powerSUITE GUI 中计算 2p2z 补

偿。
• 图 3-18 显示了电流环路的补偿参数。

• 点击 Save Comp 按钮以保存补偿。关闭补偿设计器 工具。
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• 保存 SYSCONFIG 页面。

5. 当使用非 powerSUITE 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。Compensation 
Designer 位于 C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils。

#define LAB_NUMBER (2)
#define CHANNEL_NUMBER (3)
#define SFRA_ENABLED (true)

前一个列表中引用了以下公式：boost = − p1 − p0 + 90 (7)

fp = tan boost × π180 + tan boost × π180 2 + 1  × fc (8)

fz = fc2fp (9)

G fc = Kdc 1 + fzfc 2
1 + fcfp 2 (10)

Kdc = 2πfc 1 + fcfp 2
1 + fzfc 2 (11)

图 3-17. 实验 2 的构建选项
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图 3-18. 使用补偿设计器对电流环路进行调优

3.3.5.2.2 生成和加载工程以及设置调试环境

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 这将成功生成工程。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在监视/表达式窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制

台的右上角，点击 Open，然后浏览到位于工程文件夹内的 setupdebugenv_chX.js 脚本文件。这将在观察

窗口中填入调试系统所需的合适变量。

7. 点击监视窗口中的 Continuous Refresh 按钮 ，以启用控制器中值的持续更新。

3.3.5.2.3 运行代码

使用以下步骤运行实验 2 的代码：

1. 要运行该实验，请确保按节 3.3.1 所述设置硬件。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT4CH_InputVoltageSense_V 是否处于 12V 至 15V 范围内。

4. 从 Expression Window 中设置以下参数：
• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器

• BT4CH_userParam_chX->iref_A = 7.0
• 设置 BT4CH_userParam_chX->en_bool = 1
• 有关 Expression Window 设置，请参阅图 3-19

5. BT4CH_measureVI_chX 变量显示 DC/DC 转换器的输出电流和电压。Isense1_A 显示值接近 iref_A 设置，
误差为 ±1mA。
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6. 图 3-20 显示了用于测试环路稳定性的 SFRA 设置。点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 

SFRA GUI。
7. 在 SFRA GUI 上选择器件对应的选项；例如，对于 F28P65x，请选择 Floating Point。点击 Setup 

Connection 按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击 

OK 按钮。返回到 SFRA GUI，然后点击 Connect 按钮。

8. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 启动 SFRA 扫描。完整的 SFRA 扫描需要几分钟

才能完成。完成之后，即显示包含测量值的图形，如图 3-21 所示。

9. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

10. 完成实验后，在 Expression Window 中设置以下参数以停止代码：
• 设置 BT4CH_userParam_chX->en_bool = 0
• 将 BT4CH_userParam_chX->Relay_ON 设置为 0 以禁用输出继电器

• 终止程序

图 3-19. 实验 2 表达式窗口，闭环
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图 3-20. 用于闭环电流控制的 SFRA 设置

图 3-21. 电流控制闭环频率响应

3.3.5.3 实验 3.开环电压控制 - 单通道

3.3.5.3.1 设置实验 3 的软件选项

1. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至第 2 步，否则跳至 3
2. 打开 SYSCONFIG 页面并在 Build Options 部分下执行以下步骤：

• 对于“Lab”，选择 Lab 3: Single Channel Open-Loop CV Control 实验

• 选择四个通道中的任一个
• 启用 SFRA
• 保存该页面

3. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改上述设置。

#define LAB_NUMBER (3)
#define CHANNEL_NUMBER (3)
#define SFRA_ENABLED (true)
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图 3-22. 实验 3 的构建选项

3.3.5.3.2 生成和加载工程以及设置调试环境

使用以下步骤来构建和加载工程并设置调试环境。

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 这将成功生成工程。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在监视/表达式窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制

台的右上角，点击 Open，然后浏览到位于工程文件夹内的 setupdebugenv_chX.js 脚本文件。这将在观察

窗口中填入调试系统所需的合适变量。

7. 点击监视窗口中的 Continuous Refresh 按钮 ，以启用控制器中值的持续更新。

3.3.5.3.3 运行代码

使用以下步骤运行实验 3 的代码：

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT4CH_InputVoltageSense_V 是否处于 12V 至 15V 范围内。

4. 从 Expression Window 中设置以下参数：
• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器

• BT4CH_userParam_V_I_chm->iref_A = 15.0
• 设置 BT4CH_userParam_chX->en_bool = 1
• 有关 Expression Window 设置，请参阅图 3-23

5. BT4CH_measureVI_chX 变量显示 DC/DC 转换器的输出电流和电压。Ibatsense_A 显示值接近 iref_A，误差

为 ±1mA。
6. 图 3-24 显示了用于测量开环电压控制频率响应的 SFRA 设置。

7. 点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 SFRA GUI。
8. 在 SFRA GUI 上选择器件对应的选项；例如，对于 F28P65x，请选择 Floating Point。点击 Setup 

Connection 按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击 

OK 按钮。返回到 SFRA GUI，然后点击 Connect 按钮。
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9. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完整的 SFRA 扫描需要几

分钟才能完成。完成之后，即显示包含测量值的图形，如图 3-25 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

11. 完成实验后，在 Expression Window 中设置以下参数以停止代码：
• BT4CH_userParam_V_I_chm->iref_A = 0
• 设置 BT4CH_userParam_chX->en_bool = 0
• 将 BT4CH_userParam_chX->Relay_ON 设置为 0 以禁用输出继电器

• 终止程序

图 3-23. 实验 3 表达式窗口，闭环

2-Pole/2-Zero

Compensator
Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCVout

2-Pole/2-Zero

Compensator

CC Loop

Iset
2-Pole/2-Zero

Compensator

CV Loop

Vset

图 3-24. 用于开环电压控制的 SFRA 设置
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图 3-25. 电压控制开环频率响应

3.3.5.4 实验 4.闭环电流和电压控制 - 单通道

3.3.5.4.1 设置实验 4 的软件选项

1. 要运行该实验，请确保按前面部分（即节 3.3.2）所述设置硬件。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 4: Closed Loop CCCV Single Channel
• 选择通道
• 启用 SFRA
• 关闭补偿设计器

4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。补偿设计器位于 

C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils。

#define LAB_NUMBER (4)
#define CHANNEL_NUMBER (3)
#define SFRA_ENABLED (true)
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图 3-26. 实验 4 的构建选项

图 3-27. 调优电压环路

3.3.5.4.2 生成和加载工程以及设置调试环境

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 这将成功生成工程。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为 Active。
4. 然后，点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。
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6. 要在监视/表达式窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制

台的右上角，点击 open，然后浏览到位于工程文件夹内的 setupdebugenv_chX.js 脚本文件。这将在观察窗

口中填入调试系统所需的合适变量。

7. 点击监视窗口中的 Continuous Refresh 按钮 ，以启用控制器中值的持续更新。

3.3.5.4.3 运行代码

使用以下步骤运行实验 4 的代码：

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT4CH_InputVoltageSense_V 是否处于 12V 至 15V 范围内。

4. 从 Expression Window 中设置以下参数：
• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器

• BT4CH_userParam_chX->iref_A = 8.5
• BT4CH_userParam_chX->vrefCharge_V = 0.075
• 设置 BT4CH_userParam_chX->en_bool = 1
• 有关 Expression Window 设置，请参阅图 3-28

5. BT4CH_measureVI_chX 变量显示 DC/DC 转换器的输出电流和电压。Vbatsense_V 显示值接近 

vrefCharge_V，误差为 ±0.5mV。
6. 图 3-29 显示了用于测量闭环电压控制频率响应的 SFRA 设置。

7. 点击 SysConfig 页面中的 Run SFRA 图标。此时将弹出 SFRA GUI
8. 在 SFRA GUI 上选择器件对应的选项；例如，对于 F28P65x，请选择 Floating Point。点击 Setup 

Connection 按钮。在弹出窗口中，取消选中“boot-on-connect”选项，然后选择合适的 COM 端口。点击 

OK 按钮。返回到 SFRA GUI，然后选择 Connect 按钮。

9. SFRA GUI 将连接到器件。现在可以通过点击 Start Sweep 按钮启动 SFRA 扫描。完整的 SFRA 扫描需要几

分钟才能完成。完成之后，即显示包含测量值的图形，如图 3-30 所示。

10. 频率响应数据保存在工程文件夹的 SFRA 数据文件夹下，并使用 SFRA 运行的时间添加时间戳。

11. 完成实验后，在 Expression Window 中设置以下参数以停止代码：
• BT4CH_userParam_chX->iref_A = 0
• BT4CH_userParam_chX->vrefCharge_V = 0
• 设置 BT4CH_userParam_chX->en_bool = 0
• 将 BT4CH_userParam_chX->Relay_ON 设置为 0 以禁用输出继电器

• 终止程序
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图 3-28. 实验 4 表达式窗口，闭环

2-Pole/2-Zero

Compensator
Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCVout

2-Pole/2-Zero

Compensator

CC Loop

Iset
2-Pole/2-Zero

Compensator

CV Loop

Vset

图 3-29. 用于闭环电压控制的 SFRA 设置
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图 3-30. 电压控制闭环频率响应

3.3.5.5 实验 5.闭环电流和电压控制 - 四通道

3.3.5.5.1 设置实验 5 的软件选项

1. 要运行该实验，请确保按前面部分（即节 3.3.2）所述设置硬件。

2. 如节 3.2.1 中所述打开 CCS 工程。如果使用 powerSUITE，请转至步骤 3，否则跳至步骤 4。
3. 打开 SYSCONFIG 页面并在 Build Options 部分下选择：

• 对于“Lab”，选择 Lab 5: Closed-Loop CCCV All Channels 实验
• 选择所有通道
• 禁用 SFRA 选项

• 关闭补偿设计器
4. 当使用非 powerSuite 版本的工程时，直接在 solution_settings.h 文件中修改 Build Settings。

#define LAB_NUMBER (5)
#define CHANNEL_NUMBER (5)
#define SFRA_ENABLED (false)
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图 3-31. 实验 5 的构建选项

3.3.5.5.2 生成和加载工程以及设置调试环境

使用以下步骤来构建和加载工程并设置调试环境。

1. 右键点击工程名称，然后点击 Rebuild Project。
2. 这将成功生成工程。

3. 在 Project Explorer 中，确保在 targetConfigs 项下将正确的目标配置文件设置为“Active”。

4. 点击 Run → Debug 以启动调试会话。

5. 然后工程加载到器件上，同时 CCS 调试视图变为活动状态。代码在主例程开始时停止。

6. 要在监视/表达式窗口中添加变量，请点击 View → Scripting Console 以打开脚本控制台对话框。在该控制

台的右上角，点击 Open，然后浏览到位于工程文件夹内的 setupdebugenv_chX.js 脚本文件。这将在观察

窗口中填入调试系统所需的合适变量。

7. 点击监视窗口中的 Continuous Refresh 按钮 ，以启用控制器中值的持续更新。

3.3.5.5.3 运行代码

使用以下步骤运行实验 5 的代码：

1. 使用节 3.3.1 中所示的测试设置。

2. 通过点击菜单栏中的  运行工程。

3. 在监视视图中，检查 Expression Window 中 BT4CH_InputVoltageSense_V 是否处于 12V 至 15V 范围内。

4. 从 Expression Window 中设置以下参数：
• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器

• BT4CH_userParam_chX->iref_A = 5.0
• BT4CH_userParam_chX->vrefCharge_V = 3
• 设置 BT4CH_userParam_chX->en_bool = 1
• 有关 Expression Window 设置，请参阅图 3-32

5. BT4CH_measureVI_chX 变量显示 DC/DC 转换器的输出电流和电压。

6. 更改 Iref 和 Vref 以查看恒流模式和恒压模式之间的转换。

7. 要更改电流方向，请切换 BT4CH_userParam_chX->Dir_bool。
8. 完成实验后，在 Expression Window 中设置以下参数以停止代码：

• BT4CH_userParam_chX->iref_A = 0
• BT4CH_userParam_chX->vrefCharge_V = 0
• 设置 BT4CH_userParam_chX->en_bool = 0
• 将 BT4CH_userParam_chX->Relay_ON 设置为 0 以禁用输出继电器

• 终止程序
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• 在所有通道上重复此操作，直到每个通道都关闭

图 3-32. 实验 5 Expression Window

3.3.5.6 校准

1. 要运行该实验，请确保按节 3.3.3 所示设置硬件。两点校准方法用于校准增益和偏移误差。

2. 有三种电流测量方式：
a. 在电压模式下使用外部精密电阻器和 6.5 位 DMM 测量电阻器两端的压降，然后即可计算电流。

b. 测量 TIDA-010086 板上的感应电阻器两端的电压

c. 用探针接触电路板上的 Tp1 和 Tp2 以测量分流器两端的压降

d. 使用电子负载读数，但这种方法需要高精度的电子负载或源测量单元 (SMU) 设备。

3. 要测量电压，请在降压转换器输出电压两端使用 DMM 并使用遥感终端 J8
4. 打开 SYSCONFIG 页面，选择“Lab 5”，并将 Calibration Mode 设置为 Current Calibration。图 3-33 显示

了用于电流校准的 SYSCONFIG 页面设置。

• 保存 SYSCONFIG 页面，并运行代码。

• 打开 Expression Window。

• 使用 BT4PH_userParam_V_I_chX->ibatCal_pu 参数更新输出电流。

• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器。

• 设置 BT4CH_userParam_chX->en_bool = 1。
• 将 BT4CH_userParam_chX->ibatCal_pu 设置为“0.3”和“0.5”，并记下输出电流读数。

• 在 bt4ch_gan_cal.h 文件中更新实际输出电流读数。

#define BT4CH_IBAT_ACTUAL_CH1_P1_A ((float32_t)3.59)
#define BT4CH_IBAT_ACTUAL_CH1_P2_A ((float32_t)6.02)
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• 对通道 2、3 和 4 重复这些步骤。

5. 打开 SYSCONFIG 页面，选择“Lab 5”，并将 Calibration Mode 设置为 Voltage Calibration。图 3-34 显示

了用于电压校准的 SYSCONFIG 页面设置。

• 保存 SYSCONFIG 页面，并运行代码。

• 打开 Expression Window。

• 使用 BT4PH_userParam_V_I_chX->vbatCal_pu 参数更新输出电流。

• 将 BT4CH_userParam_chX->Relay_ON 设置为 1 以启用输出继电器。

• 设置 BT4CH_userParam_chX->en_bool = 1。
• 将 BT4CH_userParam_chX->vbatCal_pu 设置为“0.2”和“0.6”，并记下输出电流读数。在 

bt4ch_cal.h 文件中更新实际输出电流读数。

#define BT4CH_VBAT_ACTUAL_CH1_P1_V ((float32_t)0.9976)
#define BT4CH_VBAT_ACTUAL_CH1_P2_V ((float32_t)2.998)

• 对通道 2、3 和 4 重复这些步骤。

6. 校准完成后，停止工程并打开 SYSCONFIG 页面，禁用校准模式。

7. 当使用非 powerSuite 版本的工程时，对于该设计，解决方案为直接在 solution_settings.h 文件中修改 Build 
Settings。将 CALIBRATION_MODE 设置为 (1) 以进行电流校准，设置为 (2) 以进行电压校准。

#define LAB_NUMBER (5)
#define CHANNEL_NUMBER (5)
#define CALIBRATION_ENABLED (true)
#define CALIBRATION_MODE (1)

图 3-33. 电流校准的构建选项 图 3-34. 电压校准的生成选项
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3.4 测试结果

3.4.1 电流负载调整率

使用节 3.3.3 中的设置测试电流负载调整率。

表 3-2. 电流负载调整率

FSR (A) 10

输出模式 充电 放电

ISET (A) 0.1 1 5 10 0.1 1 5 10

电子负载 CV 模式 终端电压读数

VSET(V) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A)
1 0.0996 0.9998 4.99993 10.0005 -0.1005 -1.0001 -5.001 -10.001

2 0.0995 0.9996 4.99995 10.0008 -0.1002 -1.00025 -5.0011 -10.001

3 0.09985 0.9995 4.99995 10.0008 -0.1005 -1.0002 -5.001 -10.0008

4 0.09925 0.9995 4.99995 10.0008 -0.1005 -1.0002 -5.001 -10.0011

误差 (mA) 0.7500 0.5 0.05 -0.8 -0.5 -0.25 -1.1 -1.1

误差 (%FSR) 0.0075 0.0050 0.0005 0.0080 0.0050 0.0025 0.0110 0.0110

3.4.2 电压负载调整率

表 3-3. 电压负载调整率

FSR (V) 5
VSET(V) 0.2 1 2 3 4 5

电子负载 CC 模式 电流读数

ISET(A) Vactual (V) Vactual (V) Vactual (V) Vactual (V) Vactual (V) V actual(V)

无负载 0.20003 1.00001 2.00001 2.99997 3.99994 4.99991

1 0.20002 0.99998 1.99998 2.99998 3.99994 5.0001

4 0.20002 1.0002 2.00004 3.00006 3.99997 5.00006

8 0.20002 1.00005 2.00002 3.00002 3.99993 5.00002

10 0.20002 1.00004 2.00002 3.00004 3.99994 5.00002

误差 (mV) 0.0300 0.0500 0.0400 0.0600 -0.0700 -0.0900

误差 (%FSR) 0.0003 0.0005 0.0004 0.0006 0.0007 0.0009

www.ti.com.cn 硬件、软件、测试要求和测试结果

ZHCU750A – NOVEMBER 2020 – REVISED DECEMBER 2025
提交文档反馈

数字控制成本优化型 10A 电池化成与测试参考设计 35

English Document: TIDUEY0
Copyright © 2026 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCU750
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCU750A&partnum=TIDA-010086
https://www.ti.com/lit/pdf/TIDUEY0


3.4.3 电流线性测试

电流控制精度取决于电流检测放大器的电流感应电阻器、增益、偏移电压和漂移。该测试在充电模式下应用两点
校准。校准后总电流误差保持在 ±0.02% 以下。图 3-35 显示了结果。
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图 3-35. 电流控制精度测试

3.4.4 电压环路线性测试

电压环路校准在空载条件下进行。图 3-36 中的黑色曲线显示了空载条件下的电压控制线性，红色曲线显示了 10A 
负载条件下的电压精度。测试证明，在不同输出负载条件下，电压环路调节误差保持在 ±0.01% 以下。
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图 3-36. 电压控制线性测试
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3.4.5 双向电流开关时间

对于充电和放电切换（请参阅图 3-37 和图 3-38），电流响应时间保持快速平滑。通过适当的调优，开关电流运行

的瞬态响应时间可以达到 400μs 以内。

图 3-37. 电流切换，充电至放电

图 3-38. 电流切换，充电至放电

www.ti.com.cn 硬件、软件、测试要求和测试结果

ZHCU750A – NOVEMBER 2020 – REVISED DECEMBER 2025
提交文档反馈

数字控制成本优化型 10A 电池化成与测试参考设计 37

English Document: TIDUEY0
Copyright © 2026 Texas Instruments Incorporated

https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCU750
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCU750A&partnum=TIDA-010086
https://www.ti.com/lit/pdf/TIDUEY0


3.4.6 电流阶跃响应

控制环路优化发生在 15mΩ 输出负载处，在 100μs 上升时间和下降时间内实现。不同的电池负载可产生不同的

结果。根据电池负载优化环路，对于实现所需的结果仍然很重要。有关电流阶跃波形，请参阅图 3-39 和图 3-40。

图 3-39. 电流阶跃上升时间

图 3-40. 电流阶跃下降时间
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4 设计和文档支持

4.1 设计文件

4.1.1 原理图

若要下载原理图，请参阅 TIDA-010086 的设计文件。

4.1.2 BOM

若要下载物料清单 (BOM)，请参阅 TIDA-010086 的设计文件。

4.2 工具与软件

工具

TMDSCNCD28P65X F28P65 controlCARD 评估模块

软件

CCSTUDIO Code Composer Studio (CCS) 集成开发环境 (IDE)
C2000WARE-DIGITALPOWER-SDK 适用于 C2000™ MCU 的 DigitalPower 软件开发套件 (SDK)。

4.3 文档支持

1. 德州仪器 (TI)，TMS320F28P65x 实时微控制器数据表
2. 德州仪器 (TI)，ADS9324 具有集成模拟前端的 16 通道 16 位 1MSPS 同步采样 SAR ADC 数据表
3. 德州仪器 (TI)，INA630 精密、126dB CMRR、间接电流反馈仪表放大器数据表

4.4 支持资源

TI E2E™ 中文支持论坛是工程师的重要参考资料，可直接从专家处获得快速、经过验证的解答和设计帮助。搜索

现有解答或提出自己的问题，获得所需的快速设计帮助。

链接的内容由各个贡献者“按原样”提供。这些内容并不构成 TI 技术规范，并且不一定反映 TI 的观点；请参阅 

TI 的使用条款。

4.5 商标
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